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作品名稱： 

華麗的轉身---紅龍果用於重金屬離子的偵測並轉換成螢光碳量子點 

摘要 

        分別從紅龍果果肉和果皮提取甜菜紅素，可見光吸收光譜 λmax=538 nm，可以與銅離子配

位，從紫紅色變粉紅色。它對銅離子具有高度選擇性，偵測極限達 1 ppm。另外將紅龍果汁

用來製備碳量子點，最佳合成條件是紅龍果汁稀釋成 1/2，以 180℃水熱法反應 2 小時，離

心、透析純化，得到粒徑 1-10 nm 的碳量子點。在紫外光-可見光吸收光譜 λmax=285 nm，為

碳量子點特有之共軛 C=C 電子躍遷。碳量子點在紫外燈的照射下會發出藍色的螢光，螢光儀

測得放射光譜 λmax=455 nm。以手機光譜儀結合樂高積木組成自製螢光光譜儀，發現在

pH=2.5 環境，稀釋倍率為 1/1000 時螢光表現最佳。當與銅離子接觸時，碳量子點的螢光會

被淬滅。碳量子點螢光為無毒、低成本，可應用於生物、醫學之奈米材料。 

壹、研究動機 

紅龍果原是南美洲的植物，台灣引進栽種後，已成為一年四季常見的水果。其果肉呈紫

紅色，富含易溶於水的甜菜紅素 Betalain，由甜菜醛胺酸 betalamic acid 與環多巴 cyclo-Dopa

結合成 1,7-重氮七聚物結構衍生物，其共軛不飽和雙鍵引起共振結構（圖二），最大吸收峰

波長 λmax 在 535-538 nm（圖一），其莫耳吸光係數 ε = 60000 L/mol1,2，只需少量甜菜紅素，

             

          圖一 甜菜紅素光譜圖                                           圖二 甜菜紅素 Betalain 結構 
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就有明顯的紫紅色。由於甜菜紅素的結構中，有胺基與羧基，可提供電子對與金屬離子配位，

形成 M2+-甜菜紅素錯合物時（式一），原先甜菜紅素共軛不飽和雙鍵的共振電子結構密度改

變，影響共振穩定度，λmax 就會往短波長移動，外觀紫紅色消失，形成 M2+-甜菜紅素錯合物

的粉紅色。基於這兩種特點，表示只要少量的甜菜紅素，即可與水中微量金屬離子反應，偵

測其濃度 3,4,10。 

    式一 

        另外，近年來的研究，有以果汁為材料，利用水熱法一步合成碳量子點之螢光物質，做

為無毒生物標記與光電領域材料 6,7。因紅龍果汁中有大量的醣類可提供碳源，且含有蛋白質

可提供氮，推測可增強碳量子點的量子產率，於是我們以紅龍果汁利用水熱法合成碳量子點

（圖三），研究該碳量子點是否也有螢光，及其螢光性質。 

 
圖三 紅龍果汁合成碳量子點 
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貳、研究目的 

一、紅龍果取得甜菜紅素偵測重金屬離子濃度 

二、紅龍果汁合成碳量子點 

三、以自製螢光光譜儀研究碳量子點之螢光性質 

參、研究設備及器材 

一、研究設備 

水果刀、豆漿布、離心機、離心管 8 支、電子天平 1 台、刮勺 2 支、稱量紙 50 張、黑

色紙箱 1 個、微量吸管（micropipette）100μL 1 支、微量吸管吸頭 100μL 10 個、滴管 10 支、

燒杯 50 mL10 個、100 mL 5 個、500 mL 2 個、1000 mL 1 個、塑膠比色管 20 個、吸濾瓶 1 個、

抽濾漏斗 1 個、科學 maker 分光器 1 個、腳架 1 台、壓力釜 1 只、樣本瓶 20mL 20 個 、紫外

燈（有 254nm、365nm ） 1 台、雷射筆 1 支、 樂高積木 1 盒 、透析膜 Spectra/Por Dialysis 

Membrane Biotech CE Trial Kit MWCO:0.5-1 kD  1 捆 、透析膜專用夾子 2 個 、數位照相機 1 台、

影像分析軟體 Image J、數據分析軟體 Excel、 PASCO SPECTROMETER PS-2600、 Agilent 8453 

UV/VIS Spectrometer；手機一台、濾紙一盒、 Hitachi F-7000 Fluorescence Spectrophotometer 

二、研究藥品  

紅龍果 20 顆、硫酸銅 CuSO4‧5H2O 500g 1 瓶、硝酸鉛 Pb(NO3)2 500g 1 瓶、R.O 逆滲透

水、乙二胺四乙酸二鈉 EDTA 500g 1 瓶、氫氧化鈉 NaOH 500g 1 瓶、鹽酸 HCl 500g 1 瓶、氯化

亞鈷 CoCl2  500g 1 瓶、硝酸鎳 Ni(NO3)2  500g 1 瓶 

肆、研究過程或方法 

一、紅龍果取得甜菜紅素偵測重金屬離子濃度 

（一）紅龍果之甜菜紅素的取得 

1.市場購買紅龍果，取 2 顆以水果刀剝去外皮，先將果肉切成數塊（圖四），豆漿布為濾網，

過濾出果肉、種子與黏稠果漿（圖五），可得紫紅色紅龍果汁 200mL。 

2.將 1.中的紅龍果汁，分別放入離心管中（圖六），共放入 8 管於離心機，以轉速 3000 rpm，

離心 30 分鐘（圖七）。 
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3.待離心機停止，取出離心管，放置試管架上（圖八）。 

 

                                    圖四                                          圖五                                          圖六 

     

                                  圖七                                         圖八                                         圖九 

4.倒出離心管中紫紅色液體上層液 6mL 於抽濾瓶中（圖九），再次過濾。過濾後的紅龍果汁，

我們稱為原汁，於日後的實驗，我們就稱為原汁的甜菜紅素。 

5.加水稀釋原汁的甜菜紅素不同倍率 1/10、1/20，1/40，1/50（圖十），以光譜儀 PASCO  

SPECTROMETER PS-2600（圖十一）測其吸收光譜（圖四十七）。 

  

                                        圖十                                                                           圖十一 

6.將 1.中的外皮放入保鮮盒，加 200mL 逆滲透水，靜置 12 小時，外皮色素溶於水（圖十二）。 

7.豆漿布為濾網，過濾 6.中的紫紅色液體（圖十三）。 

8.離心機離心 7.的液體，以轉速 3000 rpm，離心 30 分鐘後，取上層液。 

9.加水稀釋皮的甜菜紅素不同倍率 1/2、1/5，1/10，1/20（圖十四），以光譜儀測其吸收光譜

（圖四十八）。 



 

5 

 

     

                           圖十二                                         圖十三                                         圖十四 

（二）原汁的甜菜紅素用於銅離子 Cu2+濃度的偵測極限 

1.電子天平稱取 CuSO4 1.0 g，以去離子水配成 250 mL 的 CuSO4 水溶液，〔CuSO4〕= 0.016 M。 

2.去離子水稀釋原汁的甜菜紅素倍率 1/40，測量吸收光譜，於波長 538nm 處吸光度 A =  0.536，

利用比爾定律，A=εbc，甜菜紅素的 ε 值 = 60000 L/mol，b=1（∵b 是比色管寬度），可得〔甜

菜紅素〕= 8.93×10-6 M。 

3.以2.的甜菜紅素溶液，再測10次吸收光譜，記錄波長 λ= 538nm處的吸光度A值，如表二。 

4.將表中的 A 值，以電腦軟體 Excel 計算標準差。 

5.取 2.的甜菜紅素溶液 100 mL，以微量滴管，先加入 100 μL CuSO4 溶液，混合均勻後，測量

吸收光譜，記錄波長 λ= 538nm 處的吸光度 A 值。 

6.逐次加入 100 μL CuSO4 溶液，重複 5.步驟，直到加入 3.0 mL CuSO4 溶液。 

7.將 5.、6.步驟的 CuSO4 溶液濃度為橫坐標，甜菜紅素波長 λ= 538nm 處的吸光度 A 值為縱座

標，作 CuSO4 濃度與吸光度的檢量線（圖四十九）。 

8.加入過量的 EDTA 於 7.中的溶液，以光譜儀測量吸收光譜，比較在步驟 2.、6.、8.吸收光譜

圖（圖五十）。  

（三）原汁的甜菜紅素用於鉛離子 Pb2+濃度的偵測極限 

1.電子天平稱取 6.62 g 的 Pb(NO3)2，以去離子水配成 100 mL 的 Pb(NO3)2 水溶液，〔Pb(NO3)2〕

=  0.2 M。 

2.去離子水稀釋原汁的甜菜紅素倍率 1/40，以光譜儀測量，光譜圖中，顯示波長 538nm 處，

吸光度 A 值，利用比爾定律，A=εbc，甜菜紅素的 ε 值= 60000 L/mol，b=1（∵b 是比色管寬

度） ，可得〔甜菜紅素〕= 7.93×10-6 M。 

3.將2.的甜菜紅素溶液，再測 10次吸收光譜，記錄波長 λ= 538nm處的吸光度A值，如表三。 
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4.將表中的 A 值，以電腦軟體 Excel 計算標準差。 

5.取 2.的甜菜紅素溶液 100 mL，以微量滴管，先加入 100 μL Pb(NO3)2 溶液，混合均勻後，測

量吸收光譜，記錄波長 λ= 538nm 處的吸光度 A 值。 

6.逐次加入 100 μL Pb(NO3)2 溶液，重複 6.步驟，直到加入 3.0 mL 硝酸鉛溶液。 

7.將 5.、6.步驟的 Pb(NO3)2 溶液濃度為橫坐標，甜菜紅素波長 λ= 538nm 處的吸光度 A 值為縱

座標，作 Pb(NO3)2 濃度與吸光度的檢量線（圖五十一）。 

8.加入過量的 EDTA 於 7.中的溶液，以光譜儀測量吸收光譜，比較在步驟 2.、6.、8.吸收光譜

圖（圖五十二）。 

（四）皮的甜菜紅素用於銅離子 Cu2+濃度的偵測極限 

1.去離子水稀釋皮的甜菜紅素倍率 1/20，測量吸收光譜，於波長 538nm 處吸光度 A =  0.288，

利用比爾定律，A=εbc，甜菜紅素的 ε 值=60000 L/mol，b=1（∵b 是比色管寬度），可得〔甜

菜紅素〕= 4.8×10-6 M。 

2. 以 1.的甜菜紅素溶液，測 10 次吸收光譜，記錄波長 λ= 538nm 處的吸光度 A 值，如表四。 

3.將表中的 A 值，以電腦軟體 Excel 計算標準差。 

4.取 2.的甜菜紅素溶液 100 mL，以微量滴管，先加入 100 μL CuSO4 溶液，混合均勻後，測吸

收光譜，記錄波長 λ= 538nm 處的吸光度 A 值。 

5.逐次加入 100 μL CuSO4 溶液，重複 4.步驟，直到加入 5.0 mL 硫酸銅溶液。 

6.將 4.、5.步驟的 CuSO4 溶液濃度為橫坐標，甜菜紅素波長 λ= 538nm 處的吸光度 A 值為縱座

標，作 CuSO4 濃度與吸光度的檢量線（圖五十三）。 

二、紅龍果汁合成碳量子點 

（一）碳量子點的製備 

1.取紅龍果肉經由榨汁、過濾、離心純化後的紅龍果汁 10 mL 與純水 10 mL 共 20 mL，放入聚

四氟乙烯罐（圖十五）。 

2.聚四氟乙烯罐再放入高壓釜中，高壓釜鎖緊，放入已經預熱好 180℃烘箱裡 2 小時。 

3.高壓釜從烘箱拿出，放置室溫冷卻，得黃褐色液體。 

4.用離心機離心 3.的黃褐色液體，以轉速 3000 rpm，離心 30 分鐘後，取上層液。 
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5.利用透析膜透析純化黃褐色液體，透析膜的外觀很像塑膠袋，量取長度 10 公分透析膜並剪

下，將一端以寬 3 mm 捲三層，以夾子封住為下端。再將 3.中從高壓釜合成的黃褐色液體，

以滴管取約 5 毫升於此透析膜內，再將上端開口處，以寬 3 mm 捲三層，以夾子封住上端。 

      

                          圖十五  聚四氟乙烯罐與高壓釜                        圖十六  透析 

6.取一杯裝有 800 mL 逆滲透水的燒杯，先靜置 1 小時透析（圖十六）。 

7.更換逆滲透的水，靜置透析 24 小時後，鬆開夾子，以乾淨滴管吸取透析膜內的黃褐色 

液體，稱此黃褐色液體為碳量子點溶液，放入樣本瓶中（圖十七）。 

 

圖十七 碳量子點 

（二）驗證碳量子點是否有螢光 

以玻棒沾取一點碳量子點溶液，點於濾紙上，等待濾紙乾後，比較在日光燈（圖六十六）與

紫外燈照射下（圖六十七）。 

（三）碳量子點在水溶液中的螢光 

取碳量子點溶液 2.5 mL，加水稀釋到體積為 250 mL，即產物稀釋倍率 1/100，取 200 mL，與

純水 200 mL，比較在日光燈（圖六十九）與紫外燈照射下（圖七十）。 

（四）以螢光儀測量碳量子點的放射光譜（圖七十二）。 

（五）以光譜儀 Agilent 8453 UV/VIS Spectrometer 測其吸收光譜（圖七十三）。 

（六）以綠色雷射光照射，觀察是否有廷得耳效應（圖七十四） 
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三、以自製螢光光譜儀研究碳點之螢光 

（一）簡易螢光光譜儀製作 

     由於市售的螢光光譜儀價格昂貴，不易取得，為研究碳量子點之螢光性質，自製螢光光

儀。使用科學 Maker 的分光器連接手機，為手機光譜儀，具有分光器與光譜接收的功能，手

機的照相功能可拍攝、記錄分光圖與感光強度，並以樂高積木組成樣品槽，紫外燈為光源，

將三者放在互相垂直位置，其裝置如圖十八、圖十九。手機拍攝的分光圖以影像分析軟體

Image J 及數據分析軟體 Excel，即可得螢光的最大放射波長 λmax 及螢光強度。 

研究碳量子點之螢光性質，照射樣品的紫外燈波長=365 nm，設定手機拍照功能與參數，

ISO=400，曝光時間=5 秒。而標準光譜的校正，則以省電燈泡通電後會發射出多條特定波長

的線光譜，以藍光波長 436nm， 綠光波長 546nm，紅光波長 611nm，將螢光分光圖與省電

燈泡線光圖，疊圖比較，就可得知螢光波長位置所在。 

         
                         圖十八   自製螢光儀正面                                 圖十九  自製螢光儀測面 

（二）校準手機光譜儀 

1.開啟裝有螺旋式省電燈泡檯燈之電源，並將接有手機光譜儀，其狹縫對準燈源，拍攝記錄

省電燈泡之色帶中明顯的亮線，將此照片檔案輸入電腦中。 

2.開啟 Image J，在工具列 File 處，選擇 Open，開啟 1.的省電燈泡色帶照片（圖二十）。 

     

                               圖二十                                                                             圖二十一 
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3.使用矩形工具，選取一長方形範圍，工具列 Edit → Selection →Specify，設定矩形位置及大

小。並再次選取工具列 Analyze → Plot Profile，如此就可以得到橫軸為位置像素，縱軸為強度

的省電燈泡光譜圖（圖二十一）。 

4.在圖二十一中，找到最右端的波峰座標數字（473, 47.75），右端數來第二波峰座標數字

（350, 42.90）。 

5.Image J 的工具列中，選 Analyze → Tools → Curve Fitting，清除欄位的數字，再輸入 473  611，

換行輸入 350 546，選 Fit，得線性函數 y= 0.52846x +361.04，因為省電燈泡紅光波長 611nm，

綠光波長 546nm，就可以將橫坐標的位置像素轉換成波長。 

6.將圖二十一 x、y 數據全選，複製，並開啟另一軟體 Excel，將數據貼上，A 欄的數據，以 y= 

0.33849x +379.73346 的比例，轉成在 C 欄，並將 B 欄的數據貼在 D 欄。 

7.選取 C、D 欄數據，選取工作列的插入→散佈圖，即可得橫坐標為波長，縱座標為強度之已

校準省電燈泡之光譜圖（圖二十二）。我們以省電燈泡發出特定波長的色光，作為標準光譜。 

 

圖二十二  省電燈泡之標準光譜 

8.日後所有樣品拍攝照片其矩形的選取範圍就如步驟 3 設定矩形位置及大小，省電燈泡照片

為標準光譜，再以 Image J 及 Excel 處理，訂出螢光光譜波長所在位置。 

（三）以自製螢光光譜儀測量碳量子點於不同稀釋倍率的螢光光譜 

1.取 1 mL 的碳量子點液體，放入 250 mL 的燒杯中，加水稀釋到 100 mL，即碳量子點稀釋倍

率 1/100，溶液呈淡黃色，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖二十三）。 
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2.取 25mL 碳量子點稀釋倍率 1/100，放入 50 mL 的燒杯中，加水稀釋到 50 mL，即碳量子點

稀倍率 1/200，溶液呈無色，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖二十四）。 

3. 取 10mL 碳量子點稀釋倍率 1/100，放入 50 mL 的燒杯中，加水稀釋到 50 mL，即碳量子點

稀釋倍率 1/500，溶液呈無色，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖二十五）。  

4. 取 5mL 碳量子點稀釋倍率 1/100，放入 50 mL 的燒杯中，加水稀釋到 50 mL，即碳量子點

稀釋倍率 1/1000，溶液呈無色，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖二十六）。 

5. 取 2.5mL 碳量子點稀釋倍率 1/100，放入 50 mL 的燒杯中，加水稀釋到 50 mL，即碳量子點

稀釋倍率 1/2000，溶液呈無色，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖二十七）。 

6. 取 16mL 碳量子點稀釋倍率 1/1000，放入 50 mL 的燒杯中，加水稀釋到 48mL，即碳量子點

稀釋倍率 1/3000，溶液呈無色，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖二十八）。 

                            
           圖二十三          圖二十四          圖二十五           圖二十六         圖二十七         圖二十八 

7.圖二十四到二十九用 Image J、Excel 與省電燈泡標準光譜，轉成螢光光譜圖（圖五十四）。 

（四）以自製螢光光譜儀測量碳量子點於不同 pH 值環境的螢光光譜 

        在稀釋不同倍率的碳量子點，其螢光光譜圖中，稀釋倍率 1/1000 的螢光表現最佳，分別

使用鹽酸 HCl 與氫氧化鈉 NaOH 調整碳量子點 pH 值環境 

1.取 15 mL 碳量子點稀釋倍率 1/500，加鹽酸 15 mL，即為稀釋倍率 1/1000 碳量子點，pH 計

測量 pH=0.7，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖二十九）。 

2.取 15 mL 碳量子點稀釋倍率 1/500，加鹽酸 0.5mL，再加水至 30mL，即為稀釋倍率 1/1000

碳量子點，pH 計測量 pH=1.9，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖三十）。 

3.取 20 mL 碳量子點稀釋倍率 1/500，加鹽酸 0.1mL，再加水至 30mL，即為稀釋倍率 1/1000

碳量子點，pH 計測量 pH=2.5，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖三十一）。 

4.取 15 mL 碳量子點稀釋倍率 1/500，再加水 15 mL，即為稀釋倍率 1/1000 碳量子點，pH 計

測量 pH=6.8，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖三十二）。 
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5.取20 mL碳量子點稀釋倍率1/500，加氫氧化鈉0.1 mL，加水至30mL，即為稀釋倍率1/1000

碳量子點，pH 計測量 pH=11.2，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖三十三）。 

6.取 20 mL 碳量子點稀釋倍率 1/500，加氫氧化鈉 0.5 mL，再加水至 30mL，即為稀釋倍率

1/1000 碳量子點，pH 計測量 pH=11.8，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖三

十四）。 

7.取 20 mL 碳量子點稀釋倍率 1/500，取再加氫氧化鈉 15 mL，再加水至 30mL，即為稀釋倍

率 1/1000 碳量子點，pH 計測量 pH=12.8，以自製螢光光譜儀，拍攝碳量子點的螢光照片（圖

三十五）。 

       

 圖二十九          圖三十        圖三十一       圖三十二        圖三十三       圖三十四       圖三十五 

8.將圖二十九到圖三十五重覆與（三）7.相同步驟，轉換成螢光光譜圖（圖五十五）。 

（五）低濃度的碳量子點含有高濃度硝酸鉛 Pb(NO3)2、硫酸銅 CuSO4 的螢光光譜 

1.取 1 mL 的碳量子點液體，放入 500 mL 的燒杯中，加水稀釋到體積為 500mL，即碳量子點

稀釋倍率 1/500，取 15 mL 再加純水 15 mL，即為稀釋倍率 1/100 碳量子點（圖三十六） 

2.取 15mL 稀釋倍率 1/500 的碳量子點溶液，再加入〔Pb(NO3)2〕=1M，15mL，整體體積

30mL、〔Pb(NO3)2〕=0.5M、稀釋倍率 1/1000 的碳量子點溶液，以自製螢光光譜儀，拍攝碳

量子點的螢光照片（圖三十七）。 

3. 取15mL稀釋倍率1/500的碳量子點溶液，再加入〔CuSO4〕=1M，15mL，整體體積 30mL、

〔CuSO4〕=0.5M、稀釋倍率 1/1000 的碳量子點溶液，以自製螢光光譜儀，拍攝碳量子點的

螢光照片（圖三十八）。 

     
     圖三十六         圖三十七      圖三十八 
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4. 將圖四十五到圖四十六重覆與（三）7.相同步驟，轉換成螢光光譜圖（圖五十六）。 

（六）高濃度的碳量子點含有高濃度硝酸鉛、硫酸銅的螢光光譜 

1.取 1 mL 的碳量子點液體，放入 50 mL 的燒杯中，加水稀釋到體積為 50mL，即碳量子點稀

釋倍率 1/50，取 15 mL 再加純水 15 mL，即為稀釋倍率 1/100 碳量子點，以自製螢光光譜儀，

拍攝碳量子點的螢光照片（圖三十九）。 

2.取 15mL 稀釋倍率 1/50 的碳量子點溶液，再加入〔Pb(NO3)2〕=1M，15mL，整體體積 30mL、

〔Pb(NO3)2〕=0.5M、稀釋倍率 1/100 的碳量子點溶液，以自製螢光光譜儀，拍攝碳量子點的

螢光照片（圖四十）。 

3. 取 15mL 稀釋倍率 1/50 的碳量子點溶液，再加入〔CuSO4〕=1M，15mL，整體體積 30mL、

〔CuSO4〕=0.5M、稀釋倍率 1/100 的碳量子點溶液，以自製螢光光譜儀，拍攝碳量子點的螢

光照片（圖四十一）。 

     
                                                      圖三十九          圖四十          圖四十一  

4. 將圖三十六到圖三十八重覆與（三）7.相同步驟，轉換成螢光光譜圖（圖五十七）。 

（七）高濃度碳量子點含有不同濃度硫酸銅的螢光光譜 

1.取 1 mL 的碳量子點液體，放入 50 mL 的燒杯中，加水稀釋到體積為 50mL，即碳量子點稀

釋倍率 1/50，取 10 mL 再加純水 10 mL，即為稀釋倍率 1/100 碳量子點，以自製螢光光譜儀，

拍攝碳量子點的螢光照片（圖四十二）。 

2.取 10mL 稀釋倍率 1/50 的碳量子點溶液，加純水 8 mL，再加入〔CuSO4〕=1M，2mL，整體

體積 20mL、〔CuSO4〕=0.1M、稀釋倍率 1/100 的碳量子點溶液，以自製螢光光譜儀，拍攝碳

量子點的螢光照片（圖四十三）。 

3.取 10mL 稀釋倍率 1/50 的碳量子點溶液，加純水 5 mL，再加入〔CuSO4〕=1M，5mL，整體

體積 20mL、〔CuSO4〕=0.25M、稀釋倍率 1/100 的碳量子點溶液，以自製螢光光譜儀，拍攝

碳量子點的螢光照片（圖四十四）。 

4.取 10mL 稀釋倍率 1/50 的碳量子點溶液，再加入〔CuSO4〕=1M，10mL，整體體積 20mL、
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〔CuSO4〕=0.5M、稀釋倍率 1/100 的碳量子點溶液，以自製螢光光譜儀，拍攝碳量子點的螢

光照片（圖四十五）。 

         
                              圖四十二       圖四十三       圖四十四        圖四十五         圖四十六 

5.將圖四十八到圖五十一重覆與（三）7.相同步驟，轉換成螢光光譜圖（圖五十八）。 

伍、研究結果 

一、紅龍果取得甜菜紅素偵測金屬離子濃度 

（一）紅龍果之甜菜紅素的取得 

        由紅龍果來取得甜菜紅素方式有兩種，一是果肉的果汁，我們就稱為原汁的甜菜紅素，

另一是紅龍果的皮，稱為皮的甜菜紅素 

1.原汁的甜菜紅素稀釋不同倍率 

 

圖四十七 原汁的甜菜紅素稀釋不同倍率吸收光譜圖 
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2.皮的甜菜紅素稀釋不同倍率 

 

圖四十八  皮的甜菜紅素稀釋不同倍率吸收光譜圖 

（二）原汁的甜菜紅素用於銅離子 Cu2+濃度的偵測極限 

1.測量稀釋原汁甜菜紅素倍率 1/40 吸收光譜，波長 λ= 538nm，吸光度 A 值，測十次如表二 

表一  原汁的甜菜紅素用於銅離子 Cu2+濃度的偵測極限之吸光度 A 值 

次別 1 2 3 4 5 6 7 8 9 10 

吸光度 A 值 0.532 0.528 0.540 0.534 0.532 0.537 0.538 0.531 0.529 0.534 

吸光度 A 值的標準差= 0.004 

2.硫酸銅濃度與甜菜紅素吸光度 A 的檢量線（圖四十九） 

 

圖四十九  
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3.甜菜紅素、Cu2+-甜菜紅素、EDTA 加入 Cu2+-甜菜紅素後吸收光譜圖（圖五十） 

 

圖五十 

（三）原汁的甜菜紅素用於鉛離子 Pb2+濃度的偵測極限 

1.測量原汁甜菜紅素稀釋倍率 1/40 吸收光譜，波長 λ= 538 nm，吸光度A值，測十次如表三。 

表二  原汁的甜菜紅素用於鉛離子 Pb2+濃度的偵測極限之吸光度 A 值 

次別 1 2 3 4 5 6 7 8 9 10 

吸光度 A 值 0.468 0.467 0.466 0.462 0.465 0.468 0.469 0.464 0.464 0.463 

吸光度 A 值的標準差= 0.002 

2.硝酸鉛濃度與甜菜紅素吸光度 A 的檢量線（圖五十一） 

 

圖五十一 
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3.甜菜紅素、Pb2+-甜菜紅素、EDTA 加入 Pb2+-甜菜紅素後吸收光譜圖（圖五十二） 

 

圖五十二 

（四）皮的甜菜紅素用於銅離子 Cu2+濃度的偵測極限 

1.測量皮的甜菜紅素稀釋倍率 1/20 吸收光譜，波長 λ= 538nm，吸光度 A 值，測十次如表四 

表三  皮的甜菜紅素用於銅離子 Cu2+濃度的偵測極限之吸光度Ａ值 

次別 1 2 3 4 5 6 7 8 9 10 

吸光度 A 值 0.288 0.286 0.287 0.288 0.288 0.291 0.289 0.287 0.289 0.289 

吸光度 A 值的標準差=0.001 

2.硫酸銅濃度與甜菜紅素吸光度 A 的檢量線（圖五十三） 

 

圖五十三 
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檢量線斜率
， 

標準差=0.001，檢量線斜率=378.3 

Cu2+偵測極度濃度 = 0.00001149 M = 0.735 mg/L = 0.735 ppm 
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二、紅龍果汁合成碳量子點以自製螢光光譜儀研究螢光性質 

（一） 碳量子點於不同稀釋倍率的螢光光譜 

 

圖五十四 碳量子點稀釋不同倍率之螢光光譜 

（二）碳量子點於不同 pH 值環境的螢光光譜 

 

圖五十五 碳量子點於不同 pH 值環境的螢光光譜 
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（三）低濃度的碳量子點含有高濃度硝酸鉛、硫酸銅的螢光光譜 

 

圖五十六 低濃度的碳量子點含有高濃度硝酸鉛、硫酸銅的螢光光譜 

（四）高濃度的碳量子點含有高濃度硝酸鉛、硫酸銅的螢光光譜 

 

圖五十七  高濃度的碳量子點含有高濃度硝酸鉛、硫酸銅的螢光光譜 
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（五） 碳量子點含有不同濃度硫酸銅的螢光光譜 

 

圖五十八 碳量子點含有不同濃度硫酸銅的螢光光譜 

陸、討論 

一、紅龍果之甜菜紅素用於重金屬離子 Cu2+、Pb2+濃度偵測極限 

甜菜紅素大量存在於紅龍果的果肉與果皮中，在水中的溶解度很高。買來的紅龍果，外

皮與果肉分開處理，果肉切成小塊、壓碎，豆漿布過濾，儘量擰乾，果肉、種子與黏稠果漿

留在豆漿布上，得紫紅液體。離心機 3000 rpm 30 分鐘，在高速運轉下，離心管還是呈現幾

乎無法透光紫紅色液體，有一部分白色果膠質會沉在離心管的底部，以滴管吸取上層液體，

該液體稱為原汁的甜菜紅素。外皮則剪成數小塊，加去離子水靜置 12 小時，外皮色素溶於

水，再以豆漿布過濾，外皮留在豆漿布上，濾液也以離心機 3000 rpm 30 分鐘，離心管內上

層液體呈現可以透光的紫紅色，少部分固體物質沉在離心管底部，以滴管吸取上層液體，該

液體稱為皮的甜菜紅素。 

甜菜紅素的莫耳吸光係數很高，ε = 60000 L/mol，逐漸加入去離子水，原汁稀釋倍率

1/10、1/20，1/40，1/50，圖四十七原汁的吸收光譜圖，選擇以稀釋倍率 1/40 作為研究的濃

度，其〔甜菜紅素〕 = 10-5〜10-6 M。而皮的甜菜紅素，離心後稀釋不同倍率，如圖四十八皮

的吸收光譜圖，選擇稀釋倍率 1/20 作為研究的濃度，其〔甜菜紅素〕 = 5 x 10-5 M。 
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分別將硫酸銅與硝酸鉛加入稀釋倍率 1/40 原汁甜菜紅素，吸收光譜圖五十與圖五十二

甜菜紅素的 λmax 皆由 538nm 移至 510nm，形成 M2+-甜菜紅素錯合物，顏色從紫紅色（圖五

十九）轉為粉紅色（圖六十），由於甜菜紅素上 1,7 重氮七聚物的氮，提供電子對與金屬 M2+

配位，附近的的兩個羧基也與金屬 M2+鍵結，原先甜菜紅素上共軛不飽和雙鍵的共振電子結

構密度改變，電子共振效果變差，λmax 往短波長移動，影響外觀顏色，與配位金屬離子種類

無關。最後再加入過量 EDTA，形成 M2+-EDTA，因為濃度很低，溶液再度呈現只有甜菜紅素

的紫紅色（圖六十一），吸收光譜圖五十、圖五十二 λmax 皆由 510nm 移回 538nm。實驗結果

發現，只需要加入濃度 10-5〜10-4M 的微量硫酸銅溶液於甜菜紅素溶液，外觀紫紅色就會立

即改變成粉紅色，對 Cu2+偵測極限可達 1ppm。 

         

                            圖五十九                                 圖六十                                     圖六十一 

加入濃度 0.01M〜0.03M 的硝酸鉛 Pb(NO3)2 溶液於甜菜紅素溶液，即 Pb2+濃度遠大於甜

菜紅素，外觀紫紅色才會改變成粉紅色，表示 Pb2+不容易與甜菜紅素配位，推測 Pb2+沒事主

族元素，沒有空的 d 軌域提供配位，偵測極限只達 290ppm。其他的高濃度金屬離子，Ni2+、

Co2+、Mn2+加入甜菜紅素溶液，外觀都沒有改變，無法與甜菜紅素配位。 

故甜菜紅素對銅離子 Cu2+具選擇性，未來可應用於水中微量 Cu2+檢測（如：美國環保署

要求飲用水中銅濃度不能超過 1.3 ppm）。 

另外，紅龍果的果皮，也富含甜菜紅素 1，因為其高水溶性的特性，以去離子水將其從

果皮溶出，再進行過濾與離心。吸收光譜圖 λmax=538nm，也證明果皮溶出確實為甜菜紅素，

外觀呈紫紅色（圖六十二），將其稀釋倍率 1/20 用於偵測微量 Cu2+濃度亦可達 0.735 ppm，

外觀也改變成粉紅色（圖六十三），當再加入 EDTA 時，外觀又變回紫紅色（圖六十四）。這

說明果皮在甜菜紅素的提取，也可以與果肉達到相同效果，實現廢棄物再利用。 
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                            圖六十二                                 圖六十三                                 圖六十四 

 二、紅龍果汁合成碳量子點 

（一）碳量子點的合成 

合成碳量子點的方法，根據碳源的不同，可以大致地分為「自上而下」（Top-down）合

成法和「自下而上」（Bottom-up）合成法 。 

「自上而下」合成法是指將大尺寸的碳源通過物理或者化學的方法剝離出尺寸很小的碳

量子點。其合成方法將奈米碳管、碳纖維、石墨棒、碳灰和活性炭等，通過電弧放電、激光

銷蝕、電化學合成，將這些富含碳物質進行分解並最終形成碳量子點   。 

「自下而上」合成法是利用分子或者離子狀態等尺寸很小的碳材料合成出碳量子點。用

「自下而上」法合成碳量子點，大多使用有機小分子作為碳源，常用的有檸檬酸、葡萄糖、

聚乙二醇、尿素、離子液體等。其合成方法有化學氧化法、燃燒法、水熱法、微波合成法、

模板法等。 

本次碳量子點的合成方式，是以「自下而上」的水熱法。水熱法是利用高壓釜，提供水

在高溫、高壓的環境，含碳的有機物裂解成小片段，再重新組合成類似石墨，具有 C=C 雙鍵

共軛系統，外型為球狀或棒狀的碳量子點。將前面用來偵測微量銅離子的紅龍果汁，因有大

量的碳水化合物如葡萄糖、果糖、蛋白質，作為提供合成碳量子點的碳源。未加水稀釋的紅

龍果汁，我們稱為原汁，直接放入高壓釜，以水熱法 180℃高溫 2 小時，冷卻至室溫，透析

24小時，所得的產物以紫外燈照射，沒有螢光，推測可能原汁的濃度太高，合成的產物粒子

顆粒太大，粒徑可能超過 10 nm，而無法放出螢光。改變反應條件，以不同稀釋倍率的紅龍

果汁，我們發現最佳合成碳量子點的條件，是將紅龍果肉，經由榨汁、過濾、離心後所得的

紅龍果汁，加水稀釋成濃度一半，放入高壓釜，以水熱法 180℃高溫 2 小時，一步驟合成得

黃褐色液體。 

https://baike.baidu.hk/item/%E7%A2%B3%E7%BA%96%E7%B6%AD
https://baike.baidu.hk/item/%E7%9F%B3%E5%A2%A8%E6%A3%92
https://baike.baidu.hk/item/%E6%B4%BB%E6%80%A7%E7%82%AD/2628325
https://baike.baidu.hk/item/%E8%91%A1%E8%90%84%E7%B3%96
https://baike.baidu.hk/item/%E8%81%9A%E4%B9%99%E4%BA%8C%E9%86%87
https://baike.baidu.hk/item/%E9%9B%A2%E5%AD%90%E6%B6%B2%E9%AB%94/437757
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黃褐色液體裡的碳量子點顆粒有大有小，先以離心機 3000 rpm 離心 30 分鐘，只取離心

管上層黃褐色液體，顆粒太大的粒子沉於離心管底部。取上層黃褐色液體，接著透析，透析

膜的外觀很像塑膠袋（圖十六），透析膜的原理，是利用分子會從高濃度擴散到低濃度，樣

品放在具分子大小選擇性的透析膜中，進行物質交換，此時大分子的溶質會被保留，而小分

子溶質會通過透析膜移除，最終達到去除的效果（圖六十五）13。本次實驗，採用透析膜

（規格 Spectrum 500-1000）透析 24 小時，分子量在 500-1000 以下會通過透析膜移除，最後

呈現清澈黃褐色液體（圖十七）。 

 

圖六十五  透析膜透析示意圖 

玻棒沾取黃褐色液體點在濾紙上，產物在日光照射下是淡黃色，並沒有螢光（圖六十

六）；在黑暗處以紫外燈波長 365 nm 照射（圖六十七），發出強度高的螢光，黃褐色液體具

有螢光物質，稱碳量子點溶液，此一現象，適用於製成隱形墨水使用，發展成特殊防偽標誌。 

             

                                      圖六十六  日光下                             圖六十七 紫外燈下 

（二）證明碳量子點溶液是螢光物 

碳量子點的「螢光」，並非主動發光，而是「光致發光」，是一種冷發光。碳量子點經紫

外光照射，吸收能量較高的光源後，內部的電子會立刻從基態躍升到激發態 Sn（n=2、3、

4……），電子會在激發態釋放一些能量，至激發態 S1，再從 S1返回，放出波長較長，能量較

低的可見光，即為「螢光」（圖六十八）。 
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圖六十八  螢光發光機制 

一般而言，碳量子點的粒徑要在 1-10 nm 才能發射螢光，隨著碳量子點的粒徑變小，其

螢光放射會偏向藍色，且螢光強度通常會增加。這是因為當碳量子點變小時，其電子能階的

能量也會隨之增加，因此需要更高的能量來激發這些電子，使得發出的螢光顏色更偏向藍色。

同時，粒徑小的碳量子點表面積較大，因此有更多的官能基可以參與螢光發射，從而增加螢

光強度。 

1.在紫外燈下產生的螢光 

將純水與碳量子點溶液稀釋倍率 1/100 在日光燈下一起比較（圖六十九，左：純水、右：

含碳量子點），兩者外觀澄清透明；暗箱中，兩杯照射波長 365 nm 紫外燈，只有含有碳量子

點可發出藍色的螢光（圖七十），說明我們所合成的碳量子點黃褐色液體，經離心去除大顆

粒與透析移除小分子兩步驟純化，就可以得到粒徑 1-10 nm 碳量子點。另外，利用其相對無

毒的特性，未來可以延伸發展出應用在生物成像上的顯影劑使用。 

        

                                       圖六十九   日光燈                                圖七十  紫外燈 

2. 委託研究機構測量碳量子點的螢光，以螢光光譜儀（Hitachi F-7000 Fluorescence 

Spectrophotometer）測得碳量子點的藍色螢光，其放射光譜圖（圖七十一）最大放射光的強

度 λmax=455 nm，這個數據提供我們與自製螢光光譜儀測量的數據來做為比較。 
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圖七十一  以螢光光譜儀測碳量子點的螢光放射光譜圖 

3. 紫外光-可見光譜儀測量碳量子點的吸收光譜圖在圖七十二的碳量子點的吸收光譜圖中，

於波長 285nm 處屬於 π–π* 電子躍遷，是碳量子點存在共軛 C=C 特有吸收；另一波長 225nm

處屬於 n–π*電子躍遷，也證明為在碳量子點表面具有 C=O 官能基。 

 

圖七十二  碳量子點吸收光譜圖 

（三）碳量子點的廷得耳效應 

當一束雷射光透過膠態溶液，從入射光的垂直方向可以觀察到膠態溶液裡的光徑，此種

現象稱為「廷得耳效應」。「廷得耳效應」可以區別真溶液與膠態溶液的差別，當溶質的粒徑

介於 1-100 nm 時，因為光的散射可以觀察到光徑，但真溶液則無法有此現象。使用綠色雷

射光照射純水與碳量子點溶液稀釋倍率 1/100 時（圖七十三），兩者外觀澄清透明，純水沒

有光束，但含有碳量子點的水溶液有綠色光束，證明碳量子點水溶液，含有 1-100nm 的粒子。 
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圖七十三 廷得耳效應 

（四）手機光譜儀之理論 12 

本次手機光譜儀，使用科學 Maker 分光器結合手機偵測，為反射式光柵（圖七十四），

由光波的干涉原理可知，當光波的波程差 Δx 為光波長 λ 的整數倍 m 時，可形成亮紋。方程

式為 Δx = m λ，m = 1， 2， 3，......，因此若有平行光照射光柵 的入射角為 β、繞射角為 α，

則照射到光柵前的波程差為 Δx， D sin β 照射到光柵後的波程差為 Δx = D sin(α+β)， 因此亮的

波程方程式為 Dsin β+ Dsin(α +β)=mλ。方程式中的 m 稱為繞射級數，一般觀察 m=1 的干涉條

紋最清楚，將混合光分離至對應波長的不同位置。 

 

圖七十四  反射式光柵示意圖 

（五）自製螢光光譜儀 

螢光的偵測，須使光源與樣品、樣品與偵測器，兩條連線互相垂直，此時接收到的螢光

強度最強（圖七十五）。碳量子點照射紫外燈（波長365 nm），會發射藍色螢光，以自製的手

機光譜儀，偵測、拍攝、紀錄螢光分光圖， 以市售省電螺旋燈泡在通電後發出的白光來校

正光譜，白光經手機光譜儀會發射出數條特定譜線（線光譜），其影像輸入 ImageJ 軟體，會

得到橫坐標為位置像素、縱座標為光線強度的光譜圖，再利用已知中間綠色光譜線波長 

546nm，最右端紅色光譜線波長 611nm，這兩條線所在位置像素，以 ImageJ 軟體計算得線性
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函數，將此一公式重新以 Excel 軟體分析，將位置像素轉換成波長數值，作圖就可得已校準

波長其橫坐標為波長，縱座標為強度之省電燈泡標準光譜圖，用來與之後所有樣品疊圖作分

析，定出光譜波長所在位置。 

 

圖七十五 自製螢光光譜儀示意圖 

本次我們以手機光譜儀拍攝碳量子點，稀釋倍率 1/1000 螢光分光圖如圖七十六，主要

為藍光與一些綠光的連續色帶，影像分析其 λmax=455nm（圖七十七），與螢光儀 Hitachi F-

7000 Fluorescence Spectrophotometer 測得結果一致，說明自製螢光光譜儀是準確的，可以用

來偵測螢光物質之 λmax。藉 ImageJ 取得的光譜，其縱座標數值即為螢光強度。 

     

          圖七十六                           圖七十七 自製光譜儀測得的碳量子點 1/1000 之吸收光譜 

（六）碳量子點螢光性質之表徵 

1.碳量子點在不同的稀釋倍率時：碳量子點須經過稀釋才能發出螢光，這是因為碳量子點濃

度太高時，雖然含有很多的發光粒子，但是，發出的光線，會被旁邊的碳量子點吸收，稱為

自吸收。本次合成的碳量子點，我們其實不知道真正的碳量子點的濃度，藉由加水稀釋，以
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自製螢光光譜儀測其螢光強度，發現在不同稀釋倍率時，λmax 有些微差異，與螢光儀

（Hitachi F-7000 Fluorescence Spectrophotometer）比較，稀釋倍率 1/1000 時，λmax=455nm

（圖五十四）。於是以稀釋倍率 1/1000 作為探討碳量子點性質。 

2. 碳量子點在不同 pH 值環境時：碳量子點稀釋倍率 1/1000，其 pH=6.8，再分別使用鹽酸 HCl

與氫氧化鈉 NaOH 調整碳量子點 pH 值環境，圖五十五中螢光強度最強時為在 pH=2.5，並不

是酸性最強 pH=0.7，同時，在鹼性的環境 pH=11.2，螢光強度會變弱，推測在碳量子點的結

構裡有羧基，不同酸鹼的環境，會影響碳量子點結構上的電子密度，進而影響螢光強度。 

3.由於水溶液中的碳量子點表面有羧基（圖七十八），可與金屬離子相互作用（圖七十九），

導致碳量子點的螢光被熄滅，這種現象被稱為「淬滅」（quenching）。我們先分別將硫酸銅

與硝酸鉛加入稀釋倍率 1/1000 碳量子點溶液中，從螢光光譜圖五十六卻發現螢光強度減弱

不明顯，推測可能是因為加入的碳量子點濃度太低。於是將碳量子點濃度調高至 1/100，螢

光強度就減弱，如圖五十七。其中，以銅離子對螢光強度最為明顯，於波長 455 nm，螢光

強度從 14 降至 5 約下降 64%，證明銅離子淬滅碳量子點。 

 

 
圖七十八 水溶液中的碳量子點表面結構示意圖 
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圖七十九  碳量子點與銅離子鍵結示意圖 

更進一步探討不同濃度的硫酸銅加入碳量子點後其螢光，如圖五十八為螢光光譜圖。螢光隨

著硫酸銅濃度增加，螢光強度也降低，推測銅離子與碳量子點上的羧基有鍵結，形成更大的

粒子如圖七十九，或是碳量子點的電子密度改變，影響螢光發光。不同濃度的硫酸銅為橫坐

標，碳量子點螢光強度為縱座標，作圖得圖八十，線性方程式 y = -16.9x + 10.825，表示螢光

減弱有直線斜率負值關係，當銅離子濃度增加，螢光減弱，是一種濃度的淬滅。未來可以利

用這種現象來設計銅離子檢測器或者利用銅離子來調節碳量子點的螢光強度，從而實現更好

的光學性能。 

  

                 圖八十  銅離子淬滅碳量子點檢量線 

柒、結論 

        本次的研究，以紅龍果作為研究的主軸，分成兩部分，一是從紅龍果的果肉及果皮提取

甜菜紅素偵測種金屬離子，二則是用紅龍果汁合成碳量子點。 

y = -16.459x + 10.825

R² = 0.9615
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一、紅龍果的果肉及果皮提取甜菜紅素偵測種金屬離子 

（一）甜菜紅素是一種天然色素，廣泛存在於紅龍果，其中果肉和果皮中都有豐富的甜菜紅

素。在此實驗中，將市場買來的紅龍果果肉和果皮分開處理，可以分別提取甜菜紅素外，用

於食品染色，實現廢棄物再利用，讓紅龍果的使用，達到最大效益。 

（二）甜菜紅素因有長鏈不飽和雙鍵共振系統，具很高的莫耳吸光係數，且其上的胺基與羧

基與金屬離子形成錯合物時，共振系統的電子密度改變，從而改變其外觀顏色和吸收光譜。

實驗發現，只有微量的硫酸銅溶液被加入甜菜紅素溶液中時，外觀紫紅色會立即轉變成粉紅

色，表示 Cu2+和甜菜紅素能夠形成穩定的螯合配位，用於檢測微量的 Cu2+濃度，檢測極限可

達 1 ppm。 

二、紅龍果汁合成碳量子點 

（一）合成碳量子點的最佳方法是將紅龍果汁稀釋至一半濃度後放入高壓釜中，在 180℃高

溫下水熱反應 2 小時。這個步驟可以一步合成黃褐色液體，透過離心、透析純化，製備出粒

徑為 1-10nm、無毒的碳量子點，具有廷得耳效應。 

（二）碳量子點在紫外燈照射下會發出藍色螢光，波長為 455nm，因此有應用於生物成像顯

影劑的潛在可能。 

（三）以自製螢光光譜儀發現碳量子點在稀釋倍率 1/1000、溶液 pH=2.5 的條件下，螢光表

現最佳。 

（四）在紫外光可見光吸收光譜上，碳量子點有特有的 C=O、共軛 C=C 吸收峰，分別在

225nm 和 285nm 處，這是由 n-π*和 π-π*電子躍遷所引起的。 

（五）銅離子會淬滅碳量子點的螢光，並且淬滅效應與銅離子濃度有關。因此，碳量子點可

以被設計為檢測銅離子的試劑。 

紅龍果提取出的甜菜紅素可偵測微量銅離子，但因為其為不易保存的有機物，易受環境

影響、自由基攻擊而分解，於是藉由合成步驟轉換成無機碳量子點後，即可保存於室溫下，

相當安定。同樣可以偵測銅離子，且能發出藍色螢光，成為一種新型碳奈米材料，有機會應

用於生物、光電領域。兩者應用性截然不同，拓展了紅龍果的用途，不愧是華麗的轉身。 
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【評語】030202 

研究主題清楚且聚焦，方法具可行性，數據足以證實其結論，以手機

搭配分光裝置之自製光譜儀頗具創意。惟與之前科展有相似結果與方

法，作品未能將實驗過程原始手稿（實驗日誌）攜入會場，無法證明

其研究歷程，導致影響成績，殊屬可惜。且口試時只能提出對應名詞，

對於作品內容背後學理不甚了解，部分化學知識超過其認知能力，無

法回答。 

對研究之其他建議如下： 

1. 利用紅龍果探討兩個議題，是否考慮找出兩者間之聯結點？ 

2. 碳量子點對銅與鉛離子均產生螢光淬滅，與紅龍果汁比較偵測專

一性較不足，是否有解釋 ? 

3. 甜菜紅素只與 Cu2+形成錯合物，不與 Ni2+, Co2+, Mn2+ 形成錯

合物，應深入探討。 

4. “表面積大，有更多官能基，與螢光的關聯”這部份的學理應再

了解清楚。 
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